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Contents of Package:
D-Link DP-311P
Wireless Print Server
Manual, PS Admin User’s Guide and Warranty on CD
Printed Quick Installation Guide

Package Contents

If any of the above items are missing, please contact your reseller.

System Requirements:

!

!

!

Windows XP/2000/Me/98SE!

Apple Mac OS with AppleTalk!

NetWare 5.x (Native NDS)!

Internet Explorer 6.0, or Netscape Navigator version 6.0 or above,
with JavaScript enabled

!

Printer must support required Operating System!
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Introduction
The D-Link DP-311P Print Server is a wireless print server with one parallel port. With its
high-speed IEEE 1283 parallel port, the DP-311P allows those on your network to access
and share a printer wirelessly, no matter where they reside on the network.

The DP-311P is equipped with one bi-directional parallel port with a centronics connector for
direct connection to most printers available on the market today. No additional printer cable
will be required. The DP-311P also supports all major network operating systems and
protocols.

The DP-311P is an 802.11b-compliant wireless Print Server that supports both Infrastructure
or Ad-Hoc wireless modes. With the DP-311P you have the ability and convenience of sharing
a printer beyond the wired network.

The DP-311P is also easily configurable using a Web Browser or Windows based setup
wizard. Using a web browser on a PC connected to the network, configuration is simple and
straightforward with the familiar D-Link interface. PS Admin, a Windows-based configuration
program can also be used to configure the DP-311P. (The PS Admin manual is available on the
CD included with your purchase).

The DP-311P Wireless Print Server is the ideal network printing solution for small offices,
home offices, schools and other businesses that require printer sharing.
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Getting to know the DP-311P

5V-2A Power inlet
Plug the External Power
Supply into this jack

Mode Switch
Toggle UP to Configure;
Toggle DOWN for Normal
operation.

WLAN  LED
A blinking Green light
indicates a connection to
a power supply

Parallel Port
IEEE 1284 Bi-Directional
Parallel Port with a
centronics connector

Power LED
A solid Green light
indicates a connection
to a power supply

Frontview

Rearview
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Getting Started
Below is a sample network using the DP-311P. The DP-311P has a built- in Web-based
management feature that allows users to easily configure and manage multiple print
queues through TCP/IP.

For a list of printers that are compatible with the DP-311P, please see the  Appendix in this
manual. The compatibility list is not comprehensive. Even if it is not included in the list,
your printer may be compatible with the DP-311P.
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Using the  Web Configuration

On the following pages you will find a description of each of the screens that are available to
you for the web configuration of the DP-311P.

Re-power the DP-311P by pulling the power adapter plug out and re-inserting it.

After you have finished configuring the DP-311P, in order for the changes to
take effect, you must toggle the mode switch on the rear panel of the print
server back to “Normal” mode.

Set the switch to Config mode on the rear panel of the DP-311P.

Change your wireless adapter setting to Ad-Hoc or Peer-to-Peer mode. (Open
the Configuration utility for your network adapter and make sure that your
network adapter is set to Ad-Hoc mode in your configuration settings.)
(For D-Link network adapters, you can open the web-based configuration utility
and go to the Site Survey function and select the SSID named WLAN-PS. The
Channel is 1 and WEP is set to Disable. The network adapter will now be in Ad-
Hoc mode.)

Change the wireless adapter IP Address so that it is in the same IP Address range
as the DP-311P (192.168.0.x). For instructions on changing the IP Address,
please refer to the Networking Basics section in this manual. The subnet mask is
255.255.255.0.

Restart the computer.

Open your web browser and input the IP Address of your wireless print server.
The default IP Address is 192.168.0.10.

 you begin configuring the DP-311P:Before

 you have completed the configuration:After
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You can access and control the Print
Server’s configuration through the tabs on
the top of this main screen: Home, Con-
figuration, Network, Tools, and Help.

Using the  Web Configuration (continued)

Home > Status

This screen displays some basic informa-
tion about the DP-311P and the printer at-
tached to the DP-311P, if available.

Home > Wireless

This screen displays the wireless settings
and information about the print server.

After you have entered the default IP Ad-
dress of the Print Server into your web
browser address field, the configuration
utility will be available, as shown here.
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Using the  Web Configuration (continued)

Home > Network

Home > Management

This screen displays the
current TCP/IP settings;
Netware settings and
AppleTalk settings of the
print server.

This screen displays the
current SNMP settings of
the print server.
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Using the  Web Configuration (continued)

Configuration > Status

The name assigned to the Print ServerDevice Name:

System Contact: (optional) Input a System Contact name

System Location: (optional) Input a location for the Print Server

Password: Enter an Administrator password (3-8 characters)

Re-type Password: Re-type the password (when accessing the DP-311P with
password protection, the user name is admin, and the password
will be whatever you define here)

Printer Port: Select one of the following Printer Bi-directional settings:
Auto-detect for bi-directional port
Disable bi-directional port
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Using the  Web Configuration (continued)

Configuration > Wireless

Ad-Hoc: Connect to
compatibly configured
wireless clients that
have the same
chipset in peer to peer
mode

802.11b Ad-Hoc:
Connect to all
compatibly configured
802.11b wireless
clients in peer to peer
mode

Infrastructure:
Connects to
compatibly configured
wireless AP or router
in a WLAN

Mode:

Select SSID or
Manually Enter
SSID Below:

Select the SSID from the pull-down menu, or enter it manually in
the field provided. You can use the Site Survey tool provided to
obtain SSID information

Channel: Select the channel from the pull-down menu. (This is only used in
Ad-Hoc mode)

Data Transmit
Rates: Choose the data transmit rate; Auto is the default setting

Use WEP: From the pull-down menu choose 64 bit; 128 bit or Disable WEP;
Disabled is the default setting

Key Format: Choose Alphanumeric or Hexadecimal

WEP Key: Enter the WEP key in the chosen format
64-bit, Alphanumeric =  a combination of 5 digits and letters
128-bit, Alphanumeric = a combination of 13 digits and letters
64-bit , Hexadecimal = a combination of 10 digits and letters
128-bit, Hexadecimal = a combination of 26 digits and letters
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Using the  Web Configuration (continued)

Configuration > Network

Select this option to obtain settings automatically from your
DHCP server

Obtain TCP/IP settings
automatically (use
DHCP/BOOTP):

Use the following
TCP/IP settings: Select this option to enter a Static IP Address, Subnet Mask

and Gateway IP Address manually

TCP/IP Settings
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Using the  Web Configuration (continued)
Configuration > Network (continued)

Print Server Name: Input a name for the print server

Polling Time:

Netware General Settings

Enter the number of polling seconds (the minimum is 3; the
maximum is 29 seconds)

Logon Password: Enter the logon password

Apple Talk Printer Configuration
Printer Type:

Data Format:

Apple Talk Settings
AppleTalk Zone Name:

Port Name:

Use Bindery Mode:
Netware Bindery Settings

Name of the File Server:

Use NDS Mode: Enable or Disable NDS mode; Disable is the default setting

Name of the NDS Tree:

Netware NDS Settings

Name of the NDS
Context: Enter a name for the NDS context

Enter the Printer Type

Enter the Data Format

Enter AppleTalk Zone Name

Enter the Port Name

Select Enable or Disable

Select the name of the File Server

Select from the pull-down menu, if available

NDS (Novell Directory Services) is a Directory Service for Novell netware networks
that interoperates with other types of networks and provides a logical “tree structure”
view of all resources on the network, no matter where they are located.
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Using the  Web Configuration (continued)

Configuration > Management

SNMP Community Settings
Support HP WebJet Admin:
SNMP Community Name 1: Enter a name

Access Right: Select from the pull-down menu
Read-Only or Read-Write

Select Enable or Disable

Send Traps to IP Address  2:

Send SNMP Traps:
Use Authentication Traps:

Send Traps to IP Address 1: Input an IP Address for receiving Traps

Select Enable or Disable

Input an IP Address for receiving Traps

SNMP Trap Settings

Select Enable or Disable

SNMP
(Simple
Network
Management
Protocol) is a
set of protocols
for managing
complex
networks

Access Right: Select from the pull-down menu
Read-Only or Read-Write

SNMP Community Name 2: Enter a name
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Using the  Web Configuration (continued)
Configuration > Management (continued)

Tools > Factory Default

Name: Enter a name
SMB Workgroup

Printer: Enter the printer name
SMB Shared Name

If you click Factory Reset you will lose all user-defined settings and you will
have to re-configure the DP-311P!

SMB
(Server Message Block) is a message format to share files, directories and devices.
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Using the  Web Configuration (continued)
Tools > Firmware Upgrade

Visit  http://support.dlink.com for the
latest upgrades. Download the upgrade
to your hard drive and then click
Browse in this screen to locate the up-
grade. When you have found the firm-
ware file on your hard drive, click
Upgrade, in this screen, to complete
the process.

Tools > Print Test
Click Print in this window to print a
test page. Please refer to the Appen-
dix in this manual for a list of sup-
ported printers.

Help

For more information, click on any of
the Help topics listed in this screen.
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Printing
with Windows XP/2000

Set the switch to Config mode on the rear panel of the DP-311P.

Change your wireless adapter setting to Ad-Hoc or Peer-to-Peer mode. (Open
the Configuration utility for your network adapter and make sure that your
network adapter is set to Ad-Hoc mode in your configuration settings.)
(For D-Link network adapters, you can open the web-based configuration utility
and go to the Site Survey function and select the SSID named WLAN-PS. The
Channel is 1 and WEP is set to Disable. The network adapter will now be in Ad-
Hoc mode.)

Change the wireless adapter IP Address so that it is in the same IP Address range
as the DP-311P (192.168.0.x). For instructions on changing the IP Address,
please refer to the Networking Basics section in this manual. The subnet mask is
255.255.255.0.

Restart the computer.

Open your web browser and input the IP Address of your wireless print server.
The default IP Address is 192.168.0.10.
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Printing with Windows XP/2000 (continued)

Change the IP
Address and
change  the other
settings of the
DP-311P  to
conform to your
network.

Change the
mode to
Infrastructure.
Input or select
the SSID of your
wireless router or
AP. Input WEP
settings if
applicable.

11111 After you have configured the DP-311P, set the rear panel switch back to
Normal mode.

22222 Change your wireless network adapter settings (IP Address,
Infrastructure mode) so that they match your network.
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Printing with Windows XP/2000 (continued)

For Windows XP:
Go to Start > Printers and Faxes > Add a Printer

Click Next 

 
 Double-click on the
“Add Printer” icon
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Printing with Windows XP/2000 (continued)

Select “Local Printer.”

Select “Create a new port.”
At the pull-down menu, highlight
“Standard TCP/IP Port.”

Click Next 

Click Next 

Click Next 
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Printing with Windows XP/2000 (continued)

Type in the IP address of the print
server.  (i.e. 192.168.0.10)
The port name will automatically be
filled in.

Select “Custom.”
Then click “Settings.”

Click Next 

Click Settings

Click OK

Enter “lp1” for the
Queue Name.

Select “LPR”
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Printing with Windows XP/2000 (continued)

In this window, scroll down to find your
printer.  (If it is not listed, insert the driver
CD or diskette that came with your
printer.)

Click on “Have Disk.”
Then, scroll down and highlight the
printer.

Click Next 

 Click Finish 

Click Next 
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The printer is now ready for printing with
Windows XP, on your network.

 Click Finish 

Select “No”

Click Next 

At this screen, you can input a name
for this printer.

Click Next 

Printing with Windows XP/2000 (continued)

Yes
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Printing
with Windows 98SE/Me

Set the switch to Config mode on the rear panel of the DP-311P.

Change your wireless adapter setting to Ad-Hoc or Peer-to-Peer mode. (Open
the Configuration utility for your network adapter and make sure that your
network adapter is set to Ad-Hoc mode in your configuration settings.)
(For D-Link network adapters, you can open the web-based configuration utility
and go to the Site Survey function and select the SSID named WLAN-PS. The
Channel is 1 and WEP is set to Disable. The network adapter will now be in Ad-
Hoc mode.)

Change the wireless adapter IP Address so that it is in the same IP Address range
as the DP-311P (192.168.0.x). For instructions on changing the IP Address,
please refer to the Networking Basics section in this manual. The subnet mask is
255.255.255.0.

Restart the computer.

Open your web browser and input the IP Address of your wireless print server.
The default IP Address is 192.168.0.10.
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Configuration > Network

Configuration > Wireless
Printing with Windows 98SE/Me (continued)

Change the IP
Address and
change  the other
settings of the
DP-311P  to
conform to your
network

Change the
mode to
Infrastructure.
Input or select
the SSID of your
wireless router or
AP. Input WEP
settings if
applicable.

11111 After you have configured the DP-311P, set the rear panel switch back to
Normal mode

22222 Change your wireless network adapter settings (IP Address,
Infrastructure mode) so that they match your network
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Printing with Windows 98SE/Me (continued)

Please insert the
DP-311P CD into
your CD-ROM
drive and click
Install PS Admin

This picture will
appear.

Click Next

Click Next
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Printing with Windows 98SE/Me (continued)

Select the program
you want to install

DP-311P PSAdmin is
a windows based
management utility,
only Administrators
need to install this
program

D-Link Print Monitor
is the driver for print
servers in Windows
95/98/Me.You will
need to install this
program

Click Next

Click Finish
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Printing with Windows 98SE/Me (continued)

Go to Start > Settings >
Printer> Add printer or
Go to Start> Control
Panel> Printers

Double click the Add
Printer icon

Click Next

Select Local printer

Click Next
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Printing with Windows 98SE/Me (continued)

Click Next

Click Next

Highlight the printer, as shown. If the desired
printer is not on the list, click Have Disk and
insert the printer driver disk that came with your
printer to install the printer drivers

Select No

Click Finish

Go to Start >
Settings > Printers
Check to see that your
printer is installed
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Printing with Windows 98SE/Me (continued)

After the printer installation is
completed,  right-click on the
Printer icon.

Select Properties > Details >
Click Add Port

Select Other > D-link Print Port

Click OK

HP LaserJet Series II

HP LaserJet Series II
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Printing with Windows 98SE/Me (continued)

Select your DP-311P
wireless print server

Click OK

Click Apply > OK

You have
completed setting
up your printer in
Win 98SE/Me!

192.168.0.10

192.168.0.10

HP LaserJet Series II

HP LaserJet Series II
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Setting up Apple Talk or LPR
Printing in Mac OS X

Set the switch to Config mode on the rear panel of the DP-311P.

Change your wireless adapter setting to Ad-Hoc or Peer-to-Peer mode. (Open
the Configuration utility for your network adapter and make sure that your
network adapter is set to Ad-Hoc mode in your configuration settings.)
(For D-Link network adapters, you can open the web-based configuration utility
and go to the Site Survey function and select the SSID named WLAN-PS. The
Channel is 1 and WEP is set to Disable. The network adapter will now be in Ad-
Hoc mode.)

Change the wireless adapter IP Address so that it is in the same IP Address range
as the DP-311P (192.168.0.x). For instructions on changing the IP Address,
please refer to the Networking Basics section in this manual. The subnet mask is
255.255.255.0.

Restart the computer.

Open your web browser and input the IP Address of your wireless print server.
The default IP Address is 192.168.0.10.
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Change the IP
Address and
change  the other
settings of the
DP-311P  to
conform to your
network.

Change the
mode to
Infrastructure.
Input or select
the SSID of your
wireless router or
AP. Input WEP
settings if
applicable.

11111 After you have configured the DP-311P, set the rear panel switch back to
Normal mode.

22222 Change your wireless network adapter settings (IP Address,
Infrastructure mode) so that they match your network.

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)
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At the Configure pull-
down menu, select
Manually

Note: Mac OS printing is supported by Postscript printers only!

Open your System
Preferences window
and Click Network

With Mac OSX you can use AppleTalk or LPR printers using IP protocols for printing through
Print Servers. Follow the instructions below for setting up the Print Server.
After attaching the Print Server to your network using the directions provided in the Quick
Installation Guide, change the IP Address of your Macintosh to access the Print Server’s web
configuration.

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)
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The default IP Address
of the Print Server is
192.168.0.10.
Manually change your
IP Address to
102.168.0.x, where x
is any number
between 1 and 254
(except 10 which is
the IP Address of the
Print Server.)  The IP
Addresses and
Subnet Mask shown
here are examples
only

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the AppleTalk
tab in this window  and
check Make AppleTalk
Active
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

To print, open a document
and select File > Print from
the menu

Select Edit Printer List
from the Printer dialog
box

Click  Add Printer
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the printing protocol
preferred, AppleTalk or
LPR Printers using IP

AppleTalk protocol:
After selecting
AppleTalk the Port
Name of the Print
Server will be displayed.
The Port Name shown
here is an example only

Click on the Port to
which the post-script
printer is connected

In this example,
AppleTalk has been
selected

PS - 1123D6-U1 Laserwriter

Then select the printer model from the dialog box displayed here.
Click Add Printer and the Printer Port configuration  is complete.
Select the Printer Port just configured in the Print window.
Click Print to print your document
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

LPR Printers using IP pro-
tocol:
When you select LPR Print-
ers using IP Protocol, this
window  will appear

Type the IP Address of the
Print Server into the LPR
Printer’s Address field

In the Queue Name field, type in the Port Name of the post-script printer that is connected to
the Print Server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.
In the Queue Name field, type in the Port Name of the post-script printer that is connected to
the Print Server. The Port Name illustrated here is only an example.

Select the printer model from the dialog box

Click Add and the process is complete

Close all Print Center windows, select the Printer Port that was just selected

Click Print to print the document.Click Add and the process is complete

ATALK_PS
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Setting up Apple Talk Printing
in Mac OS 9

The AppleTalk network protocol is used with computers using the MacOS operating system.
It can be used for network communications over standard Ethernet or Fast Ethernet using the
EtherTalk transport, or over a proprietary low-speed LocalTalk transport.

Your Print Server can be used for network printing to PostScript printers. You can print from
any MacOS computer connected to your Ethernet network, either directly using an EtherTalk
connection, or indirectly through a LocalTalk-to-EtherTalk router.

NOTE: The Chooser name of a printer connected to one of the Print Server’s ports is the
same as its Port Name. If you are using AppleTalk printing, you will need to make sure that
every Port Name is unique among all of the network printers in your
AppleTalk zone. The Port Names shown in this manual are examples only.

Setting up the Print Server for AppleTalk Printing

To set up your Print Server so that it can be used for AppleTalk printing:

Select the Network tab and scroll to the bottom to the AppleTalk protocol section

Change the IP Address on one of the computers on your network to 192.168.0.x, where
x is any number between 11-254

Type 192.168.0.10 into the address field of your web browser. 192.168.0.10 is the
default IP Address of the DP-301U

Make sure the AppleTalk protocol is enabled in your Macintosh!

!

!

!

If your AppleTalk network is divided into AppleTalk zones, you will have to specify which
zone the Print Server should be in. You should locate the Print Server in the same zone
as most of the users who will be using it. If your network is not divided into zones, the
AppleTalk Zone field should contain a single asterisk “*”

!

Note: Mac OS printing is supported for Postscript printers only!
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Printing from MacOS Client
Workstations

The exact procedure for selecting a PostScript printer connected to your Print Server may
vary slightly, depending on what printer driver version you are using. The procedure described
below assumes you are using the LaserWriter 8.

To choose a printer connected to your Print Server as your MacOS
workstation’s default printer,

Open the Chooser by selecting Chooser from the Apple menu

Select the LaserWriter 8 icon on the left. Make sure that AppleTalk is set
to Active

A list of all networked PostScript printers will be displayed:

Double-click the name of the
Printer Port you wish to use.
The Printer Ports shown are
examples only

ATALK_PS
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Printing from MacOS Client Workstations (continued)

If you have not previously
set this printer as the
default, your computer will
prompt you for a PostScript
Printer Description file.
Choose Select PPD.

If you wish to access this setting in the future, you can use the Setup button in the
Chooser window

The selected printer will become your computer’s default printer. You may need to choose
Page Setup in any applications you have open

Select the appropriate printer
description file for your printer

Click Open
(If your printer is not listed,
click Generic to use a
generic printer description)
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Networking Basics
Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.
Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about networking
computers using Windows 2000, ME or 98SE.

Go to Start>Control Panel>Network Connections

When this screen appears, Click Next
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Networking Basics (continued)

Please follow all
the instructions in
this window:

Click Next

 In this window,
select the
best description of
your computer.
If your computer
connects to the
internet through a
gateway/router,
select the second
option as shown.
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Networking Basics

Enter a Computer
description and a
Computer name
(optional.)

 

Click Next

Enter a Workgroup
name.  All computers
on your network
should have the
same Workgroup
name.

Click Next

(continued)
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Networking Basics

Please wait while
the Network
Setup Wizard
applies the
changes.

 

When the changes
are complete,
Click Next.

Please wait while
the Network
Setup Wizard
configures the
computer.
This may take a
few minutes.

(continued)
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Networking Basics

In this window, select
the best option.  In
this example, Create
a Network
Setup Disk has been
selected.
You will run this disk
on each of the
computers on your
network.

Insert a disk into the
Floppy Disk Drive, in
this case drive A.

Format the disk if you
wish, and Click Next

Click Next

(continued)



                                                                                       47

Networking Basics

Please wait while the Network Setup Wizard copies the files.

Please read the information under Here’s how in the screen below.  After you
complete the Network Setup Wizard you will use the Network Setup Disk to run
the Network Setup Wizard once on each of the computers on your network.  To
continue, Click Next.

(continued)
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Networking Basics

The new settings will take effect when you restart the computer.  Click Yes to
restart the computer.

You have completed configuring this computer.  Next, you will need to run the Net-
work Setup Disk on all the other computers on your network.  After running the
Network Setup Disk on all your computers, your new wireless network will be
ready to use.

(continued)
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Networking Basics
How to assign a Name to your computer (continued)
To name your computer, please follow these directions in Windows XP:

Click Start (in the lower left corner of the screen)

Right-click My Computer
Select Properties and Click

!

!

!

!

!

!

Select the Computer
Name tab in the System
Properties window.

You may enter a
Computer Description
(optional).

To rename the computer
and join a domain, Click
Change.

(continued)
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Networking Basics
How to assign a Name to your Computer (continued)

! In this window, enter the
Computer name

Select Workgroup and enter
the name of the Workgroup

All computers on your network
must have the same
Workgroup name.

Click OK

!

!

!

How to find your IP Address in Windows XP

The adapter-equipped computers in your network must be in the same IP Ad-
dress range. To verify the IP Address of the adapter, please do the following:

Right-click on the
Local Area Con-
nection icon in
the task bar

Click on Status

!

!

(continued)
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Networking Basics (continued)
How to find your  IP Address in Windows XP (continued)

This  window will appear.

Click the
Support tab

Click Close

!

!

Assigning a Static IP Address in Windows XP/2000
Note:  Residential Gateways/Broadband Routers will automatically assign IP
Addresses to the computers on the network, using DHCP (Dynamic Host Con-
figuration Protocol) technology.  If you are using a DHCP-capable Gateway/
Broadband Router you will not need to assign Static IP Addresses.
If you are not using a DHCP capable Gateway/Broadband Router, or you need
to assign a Static IP Address, please follow these instructions:

!

!

Go to Start

Double-click
Control Panel
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Networking Basics (continued)
Assigning a Static IP Address in Windows XP/2000 (continued)

! Double-click
Network
Connections

!

! Double-click
Properties

Right-click Local Area
Connections
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 Input your IP Address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP
Address of 192.168.0.2, the
other computers should
have IP Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The
subnet mask must be the
same for all the computers
on the network.)

Networking Basics  (continued)
Assigning a Static IP Address
in Windows XP/2000 (continued)

 Input your DNS server
addresses. (Note: If you
are entering a DNS server,
you must enter the IP
Address of the Default
Gateway.)

!

The DNS server information will be supplied
by your ISP (Internet Service Provider.)

! Click OK

Click Internet Protocol
(TCP/IP)

Click Properties

!

! Select Use the
following IP Address in
the Internet Protocol
(TCP/IP)Properties
window.

!

!
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Networking Basics  (continued)
Sharing an LPR Printer (continued)
To share an LPR printer (using a print server,) you will need a Print Server such as the DP-
311P.  Please make sure that you have run the Network Setup Wizard on all the computers
on your network. To share an LPR printer, please follow these directions:

Go to Start >
Printers and
Faxes

Click on Add
a Printer

The screen to the
right will appear

Click Next

Select
Local
Printer...

Click Next

!

!

!

!

!
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Networking Basics  (continued)
Sharing an LPR Printer (continued)

Select Create a new port

From the pull-down menu,
select Standard TCP/IP
Port, as shown.

Click Next

Please read the instruc-
tions on this screen

Click Next

Enter the Printer IP Address
and the Port Name, as
shown.

Click Next!

!

!

!

!

!

!
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Networking Basics
Sharing an LPR printer (continued)

In this
screen,
select
Custom.

Click
Settings.

Enter the Port
Name and the
Printer Name
or
IP Address.

Select LPR.

Enter a
Queue Name
(if your Print-
Server/
Gateway has
more than one
port, you will
need a Queue
name.)

Click OK.!

!

!

!

!

!
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Networking Basics
Sharing an LPR printer (continued)

Select Keep existing
driver.

If the printer driver is already installed, do
the following:

Click Have Disk.

Insert the printer driver disk that
came with your printer.

Select the printer you are
adding from the list of
Printers.

Click Finish.

This screen will show you
information about your
printer.

!

!

!

!

!

!

!

Click Next.
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Networking Basics
Sharing an LPR printer (continued)

Note:  You must run the Network Setup Wizard on all the computers on your network before you
run the Add Printer Wizard.

Please run the Add Printer
Wizard on all the computers
on your network in order to
share the printer.

Click Finish to complete the
addition of the printer.

This screen will display information
about your printer.

Select Yes, to print a test page.

Please remember the name of
your printer. You will need this
information when you use the
Add Printer Wizard on the other
computers on your network.

You can rename your printer if you
choose. It is optional.

!

!

!

!

!

!

!

Click Next.

Click Next.
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Technical Specifications

Parallel-          1 DB-36-pin male Centronics port, supporting bi-
         directional communication

Standard- Complies with IEEE 802.11b Direct Sequence Spread
Spectrum (DSSS) standard

Radio Frequency- 2.4GHz  Band

Media Access Control
Method-

Modulation Types- CCK (11 & 5.5Mbps), DQPSK (2Mbps),
DBPSK (1Mbps)

Operating Channels- 11 Channels (U. S. & Canada)
13 Channels (Pan Europe)
14 Channels (Japan)

Modes- Ad-Hoc and Infrastructure (User-definable via Web
management interface)

Data Transmission Rate- Up to 11Mbps, with auto-fallback feature to 5.5Mbps,
2Mbps, 1Mbps

Output Power- +13 ~ +17dBm (typical +15dBm)

Radio Sensitivity (BER < 8%)- Min. -82 dBm for 11Mbps
Min. -86 dBm for 5.5Mbps
Min. -88 dBm for 1/2Mbps

Type of Antenna- Internal, PIFA Type(Peak Gain: 2)

WEP (Wired Equivalent
Privacy) Encryption- Supports 64- and 128-bit (alphanumeric & hexadecimal)

Carrier Sense Multiple Access / Collision Avoidance
(CSMA/CA), with ACK

Network Protocol Support          TCP/IP, IPX, NetBEUI, AppleTalk, LPR,
                                               SMB (over IP)
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Technical Specifications (continued)

CPU- ARM7-based RISC microprocessor, operating at 50MHz

Flash- 1Mbytes

System Memory- 2Mbytes SDRAM

Parallel Port- 1 DB-36-pin male Centronics port, supporting bi-directional
communication

Size- 53 x 64mm (tolerance: 1mm)

Power Supply- 5V, 2.0A

EMI Certifications- CE / FCC Class B

Temperature- Operating: 0 ~ 50°; Storage -5 ~ 65°

Humidity- Operating: 0 ~ 70%; Storage 0 ~ 80%
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You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within
Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our website,
or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:

•  Serial number of the unit

•  Model number or product name

•  Software type and version number

Technical Support
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Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

• D-Link or its authorized reseller or distributor and
• Products purchased and delivered within the fifty states of the United States, the District of

Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or
FPO.

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.
1-Year Limited Warranty for the Product(s) is defined as follows:

• Hardware (excluding power supplies and fans) One(1) Year
• Power Supplies and Fans One (1) Year
• Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at no
charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not be new or
have an identical make, model or part.  D-Link may in its sole discretion replace the defective Hardware (or any
part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent (or
superior) in all material respects to the defective Hardware.  Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase.  If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware.  All Hardware (or part thereof) that
is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon
replacement or refund.
Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and
operated as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the
magnetic media on which D-Link delivers the Software will be free of physical defects.  D-Link’s sole obligation
shall be to replace the non-conforming Software (or defective media) with software that substantially
conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion.  Except
as otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software.  Software will be
warranted for the remainder of the original Warranty Period from the date or original retail purchase.  If a
material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not
practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link.  The license granted respecting any Software for which a refund is given
automatically terminates.
Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software of
D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product
is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as
described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim:  The customer shall return the product to the original purchase point based on its return
policy.  In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:

Warranty and Registration
(USA only)
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• The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the
same.

• The original product owner must obtain a Return Material Authorization (“RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
is provided.

• After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package.  Do not include any manuals or
accessories in the shipping package.  D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery
(“COD”) is allowed.  Products sent COD will either be rejected by D-Link or become the property of
D-Link.  Products shall be fully insured by the customer. D-Link will not be held responsible for any
packages that are lost in transit to D-Link.  The repaired or replaced packages will be shipped to the
customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

• Return Merchandise Ship-To Address
USA: 53 Discovery Drive, Irvine, CA 92618
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing
requirements, or for which an RMA number is not visible from the outside of the package. The product owner
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective
or non-conforming.
What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs in
shipment, due to act of God, failures due to power surge, and cosmetic damage;  Any hardware, software,
firmware or other products or services provided  by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product.  Repair by anyone other than
D-Link or an Authorized D-Link Service Office will void this Warranty.
Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY WHERE
A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90)
DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF
THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED
WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH
OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR,
REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM
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Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied
warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement:  No part of this publication or documentation accompanying this Product may be
reproduced in any form or by any means or used to make any derivative such as translation, transformation,
or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United
States Copyright Act of 1976.  Contents are subject to change without prior notice.  Copyright© 2002 by D-Link
Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local D-
Link office.

Register your D-Link product online at http://support.dlink.com/register/

 (07/31/2003)

FCC Caution:

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.  The
antenna(s) used for this equipment must be installed to provide a separation distance of at least eight
inches (20 cm) from all persons.

This equipment must not be operated in conjunction with any other antenna.

 LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES ARE
EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to
this equipment; such modifications could void the user’s authority to operate the equipment.
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Appendix 1:
DP-311P Printer Compatibility List

Brand Printer’s Name
Brother HL 1260
CANON S520
CANON BJC-4300
CANON BJ-330
CANON BJ F9000
CITIZEN GSX-230
EPSON STYLUS—color670
EPSON STYLUS C60
EPSON PM 700C
EPSON LQ-680
EPSON LQ-2170C
EPSON LQ-100 ESC/P2
EPSON EPL 5800
FUJITSU DL700
FUJITSU DL6400 Pro
FUJITSU DL3400
HP LaserJet 6P
HP LaserJet 1200 series
HP DeskJet 810C
HP DeskJet 500
HP DeskJet 400
HP DeskJet 1220C
HP DeskJet 1125C
Panasonic KX-P1121
STAR NX-2420
Kyocera FS-1010
LEXMARK Z43
NEC PINWRITER P8000C
NEC PINWRITER P5300
NEC PINWRITER P2200
OKI Microline 391 turbo
Panasonic KX-P1624
Panasonic KX-P1121
STAR NX-2420
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Appendix 2:

DP-311P Incompatible Printer List
No. Printer Model
1. ALPS AlpsLSX-1600
2. Canon BJC 610, 620
3. Canon BJC 5100, 5000
4. Canon FAX L350
5. Canon LBP 660
6. Canon LBP 800
7. Canon LBP 430W
8. Citizen NoteBOOKII/PN48
9. Epson Stylus Scan 2000
10. Epson Stylus Scan 2500
11. Lexmark ColorJet Print 2050
12. Olivetti PG304
13. OKI Page 8W
14. HP Leaser Jet 1000
15. EPSON 5900L
16. Canon LBP 810
17. Samsung ML-1210
18. Epson 6100L
19. Epson AcuLaser C900
20. Epson AcuLaser C1000

Please note that the DP-311P:
- Cannot support all GDI printers
- Supports only Postscript printers with Mac OS
- May not work with MFP (Multi Function Printers)
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Appendix 3:

Alternate Ways of Upgrading the Firmware
in Netware / Windows / Unix
If you do not choose to use the Firmware upgrade feature in the DP-311P web browser based
configuration utility, you can use one of the following Operating System specific procedures:

Before you proceed to upgrade the print server, check http://
support.dlink.com for the latest firmware upgrades, and
download the latest firmware onto your hard drive.

Please ensure that the print server is not printing jobs. You
must wait till all print jobs are finished before you can proceed.

1

2

Upgrading the print server from PSAdmin
1. Log into your NetWare file server as a Supervisor  (Admin.) or equivalent.

2. Ensure binary file is located in the PSAdmin directory.

3. Run PSAdmin from your Windows PC.

4. Click the Upgrade icon in tool bar.

Upgrading the print server from Windows 2000/XP
1. Ensure that the binary file is located in your current working directory.

2. At 2000/XP’s DOS prompt type “tftp <print server’s IP address > get upgrade”.

3. Type “tftp –i <print server’s IP address> put mps23.bin”.

4. Wait for the “transfer is successful” message.

5. The upgrade is complete!
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Appendix 3:
Alternate Ways of Upgrading the Firmware in Netware / Windows / Unix
(continued)

Upgrading the print server from UNIX (Through TCP/IP)

1. Log in as root.

2. Ensure that the binary file is located in your current working directory.

3. Type “tftp <print server’s IP address>”.

4. At tftp prompt, type “get upgrade”.

5. Change to binary mode.

6. At tftp prompt, type “put mps23.bin”.

7. Wait for the file transfer to complete.

8. Quit from tftp.

9. The upgrade is complete!.
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